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HScope for the '90's
About a decade (and a half) late

by Gary A. Appel

Almost ten years after the introduction of Windows '95, it seemed time to move up to a
Windows version of the software used to control and capture waveforms from the Heathkit
4850 Digital Memory Oscilloscope. Only problem was, there didn't seem to be one.

Many searches on the Intenet revealed nothing in the way of a Windows interface for the old
Heathkit hardware. With nothing available, it appeared that the only way to move up into the
90's, was to write my own.

And thus the decision was made to develop this, "HScope for the '90's", a new Windows
interface for the old Heathkit Digital Memory Scope.

My primary desire in developing this application, was to provide a Windows based control for
the 4850, along with the abililty to capture a bitmap of the vritual scope, for inclusion into other
documents. Rudimentary capability has also been included for printing.

Aftering retiring this past year, I pulled out the old program listing, and have added a few new
features. We now have time and voltage cursors, the ability to choose your own color
combinations, and slightly improved print capabilities for plotted waveforms. I may have also
fixed a bug or two, but I do a pretty bad job of documenting bug fixes.

I am passing this software along in the hopes that others will be able to put it to good use,
rather than putting the 'scope up for auction on ebay, because they no longer want to deal
with running DOS to keep the 'scope alive.

This software is copyrighted, please review the copyright message for details.
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Products that are referred to in this document may be either trademarks and/or registered trademarks of the
respective owners. The publisher and the author make no claim to these trademarks.
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responsibility for errors or omissions, or for damages resulting from the use of information contained in this document
or from the use of programs and source code that may accompany it. In no event shall the publisher and the author be
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1 Introduction

1.1 Welcome to the 90's

Welcome to the state of the art of the 90's, that is - Windows 95, and later. The hardware may be
obsolete, but at least we can make it more 90's friendly by adding a Windows interface for the 'scope.

Perhaps you have been using your Heathkit digital memory oscilloscope only infrequently, hauling out
some old MS-DOS machine to capture the waveforms. Perhaps you wanted to paste them into a
document, so you carefully captured the screen while displaying a waveform, pasted it into some
graphics program, and then captured that into the clipboard for importing into some other program,
perhaps Word. And then the old computer died, so you tried running the Heathkit program in a DOS
window, only to discover that the program wasn't able to display the traces in the DOS Window.

Well, that's what happened to me, so I set out to look at the hand shaking, to see if I could figure out
what I needed to do to get the old Heath software to run on the new machine. But in the back of my
mind I wondered, wouldn't it be much nicer if I just had a Windows program to control the oscilloscope,
so I could capture the screen directly into the clipboard. Sort of like moving up into the 90's.

So I searched the Internet for "Heath", "Scope", "Digital", and maybe a few other words, but it looked
like the only software I could find for the Heathkit Scope was the old Heathkit software. So if I really
wanted a Windows program, I decided that I was going to have to write it myself.

So here it is. I call it HScope for the 90's, and to think, and to think, we're only halfway into the first
decade of the 21'st century. A little bit late, but the price is right, and you don't have to bid against
twenty other guys on e-bay to get it. I just hope that a few other people decide to use it, at least as long
as the Heathkit Scopes continue to run.

Late breaking news!
As of June 2007, I'm retired.  After spending a almost a year getting ready to move, and several
months at the other end of the move getting moved in, we've finally gotten settled, and I've had some
spare time to get back to important things, like HScope fo the 90's.  And so, here it is - HScope for the
90's, revision 2.1. It's new, it's improved, and it's still free. Your 'scope will feel better, you'll feel better,
you'll probably lose ten pounds, and the sun will shine on your next picnic. I've added cursors, and the
ability to choose your colors (at the request of one of our dedicated users.)

Feel free to contact me. As a result of our recent move, my e-mail address has changed from what it
was when version 1.0 was released. My present e-mail address (as I am typing this) is:

garyappel@hawaiiantel.net.

1.2 Introduction

HScope for the 90's is intended to be a simple application used to control the Heathkit Digital Memory
Oscilloscope, and to allow capturing the waveforms displayed on the 'scope. The primary impetus for
creating this application was the need to be able to capture plots, and waveforms for inclusion into
other documentation. As a result, it does not have all the features you'd expect of a commercial
application. For example, the print capability is very rudimentary, and there are no math functions.

Waveforms can be stored to the disk, and recalled later for viewing. HScope for the 90's uses the
Multiple Document Interface, allowing the user to be collecting data on the scope, while also displaying
waveforms previously captured, or retrieved from a disk file.



Introduction 4

© 2008 ... Gary Appel

Although there are no math functions defined between traces, each trace can display either the data as
it is transferred from the scope, or an average of many traces acquired over time, or the minimum or
maximum of many traces acquired over time. Cursors can be displayed on the virtual 'scope, allowing
the user to measure timing and/or voltages.

The virtual 'scope face, including the traces, can be saved to a file, for later recall. In addition, the
setup state of the scope can be saved to a file, to allow the user to return the scope to a previously
saved state.

Either of the two traces can be plotted - that is, the trace will be re-plotted in a separate window, with
the axes labeled appropriately based on the vertical and horizontal scale factors. This allows the user
to capture a plot for inclusion into another document, with the scales properly labeled.

And finally, several commands can be issued, to DC zero the channels, arm (or trigger) the scope, turn
the external scope display on and off, and reset the scope to it's power up state.

If the Digital Memory Scope is not connected to the computer, or if it is not turned on, the application
can still be used to retrieve and view saved waveforms files.

1.3 Setting up Communications

Once the application has been installed, it can be launched in any standard manner. The first window
to pop up will be a window for setting up the serial port. Set the baud and Communications Port
appropriately. The baud rate can be selected by using the up and down arrows to scroll, and then
selecting the desired baud rate by clicking on it. Select the desired serial port by clicking on it. Note that
the program has only been tested at 9600 baud. Pressing the Cancel button will accept the default
baud rate of 9600, and the COM1 port. Pressing the OK button will set up the communications
according to the highlighted baud rate and port.

1.4 It's Running

Once the serial communications parameters have been selected, by closing the setup dialog, the
virtual scope window will open. This should look somewhat familiar to users of the Heath software, as
the layout has been set up similar to the Heath display.
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If the Digital Memory Scope has just been turned on, the display should come up matching the display
above. If the 'scope has already been turned on, and it's state changed, the display should come up
matching the present settings of the 'scope. If the 'scope is not turned on, or connected, the settings
will not be meaningful.

The major part of the window will contain the 'scope traces. To the right are the controls associated
with the two vertical channels, and time base of the 'scope. The layout is similar to the original HScope.
The top four controls are associated with channel 1, while the center four controls are associated with
channel 2. The lower five controls are associated with the horizontal sweep, and the triggering.

The controls are changed by clicking on the up and down arrows. It might take a moment for the scope
to respond. To make large changes in the switch position, click the switch multiple times. You need not
wait for the hardware to respond before clicking again. After the hardware re-configures from the
commands, it will display it's settings on the virtual control panel. This allows a visual feedback of the
hardware settings, to assure the 'scope is configured as desired.

Changes made by pressing the buttons on the scope should be reflected on the virtual control panel.

The File menu items are used for saving and recalling waveforms and setup files, and printing a copy
of the display. The edit menu is used for copying the display to the clipboard. Averaging and minimum
or maximum hold set up using the Aquire menu items. The Control menu allows the user to issue
certain commands directly to the scope. And the Plot menu item allows the traces to be plotted with
axes to match the current 'scope setup.

As of revision 2.1, two additional main menu items have been added. Items accessed through the
cursor menu allow two vertical or horizontal cursor lines to be displayed on the 'scope screen, with a
display of the times or voltages represented by the location of the cursor lines. Items accessed through
the color menu allow the user to set the colors of items displayed on the virtual display.
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At the bottom of the scope are several status displays. The right most status panel will display the
status of the scope, in terms of transferring data, sampling, and whether the latest trace was triggered
or not. The status panel immediately to it's left will display information if the software is in the process
of averaging.  Other status panels will display the time or voltage corresponding to the cursors, and
frequency of a single cycle between the two time cursors.

2 Trace Windows

2.1 Trace Window Description

HScope 90's will come up with a single Trace Window maximized. If the Trace Window is set to it's
normal (not maximized) configuration, it will appear as a daughter window in the application.

As shown above, the virtual controls are associated with the Trace Window (seen in the daughter
window here), while the menu items (part of the main window) are not. The virtual controls refer to the
trace displayed in the Trace Window, while the menu items may refer to the Active window, the
highlighted window, or the application, depending on the menu item.

Notice that the caption for this Trace Window is "Active". This indicates that this Trace Window is
periodically displaying the updated scope data. A window that is not displaying the updated scope data
will be labeled as "InActive". If the trace has been saved, the file name will also be displayed.
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When more than one Trace Window is displayed, the user can switch between windows by selecting
one of the other windows either with the mouse, or through the Window menu item. It will become the
highlighted window.

2.2 Creating a New Plot Window

A second Trace Window may be created by clicking on the File | New menu item. This will create a
new window, which will immediately become the Active Trace Window.

In this example, a new Trace Window has been opened, after having already captured a waveform in
the original Trace Window. Notice that the sweep time per division has been decreased after opening
the new Trace Window. This new sweep rate is displayed with the new Trace Window, while the
original Trace Window retains the sweep time in use when it captured the same waveform.
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2.3 Saving a Trace Window

Any Trace Window can be saved by clicking on the File | Save Plot or File | Save Plot As... menu item.
If the Trace is not already named, or if the Save Plot As... menu item is used, a Save As Dialog will
open, allowing the user to supply a file name. By providing a name, and clicking on Save, the Trace
Window will be saved as a file.

In this example, the InActive Trace Window was selected, and saved with the file name "Trace". Notice
that the window is still labeled as "InActive", but now also carries the file name "Trace".

2.4 Recalling a Trace File

A Trace Window can be recalled from a file by clicking on the File | Recall Plot menu item.
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In this example, the Trace Window named "Trace" has been recalled from a file. Notice that this
window is labeled as a File, rather than Active or Inactive. The file name is included in the window
caption.

2.5 Closing a Window

A Trace Window may be closed by clicking on the X in the upper right hand corner. The most recently
highlighed window will then become the newly highlighted window. If the Active Trace Window was
closed, this newly highlighted window will become the Active Trace Window, overwriting any traces that
were displayed in the window.
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In this example, the recalled trace window was highlighted, just before closing the active window. As a
result, the recalled window is the newly Active Trace Window. This window was displaying a Trace
Window recalled from a file, but is now labeled as the Active Trace Window. The file name "Trace" is
still associated with this window, and will be used if the Trace Window is saved.

The virtual control panel will be updated to match the hardware, once the window becomes Active.

2.6 Printing a Trace Window

Once a trace has been captured, it can be printed. On the Trace Window, click on the File | Print menu
item. This will bring up the Print Dialog. Clicking OK on the Print Dialog will send a copy of the virtual
scope display to the printer. The print command is very rudimentary, and produces a bit-map image of
the virtual 'scope face. The print out can be made smaller or larger by making the Trace Window
smaller or larger.
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3 Virtual Controls

3.1 Vertical Controls

Each of the two channels have four vertical controls associated with it. Each of these controls can be
adjusted by clicking on either the up, or the down arrow. The controls are identical for the two
channels.

The first control sets the vertical sensitivity per divivion. This will be displayed in volts, or millivolts.

The second control sets the coupling - DC, AC, GND, and OFF. If the channel is off, the trace
corresponding to that channel will not be displayed. If both channels are off, no traces will be displayed,
and the Status Panel will display the message - "No Data".

The third control determines whether the trace will be displayed normal, or inverted. This will affect only
this display. If the data is plotted, the plotted data will not be inverted.

The final control sets an offset, to allow the traces to be offset from each other on the display. Note that
the trace is only valid for approximately five divisions above and below the offset value. Thus, if the
offset is set to much more than one division up or down, the display can become clipped. The offset
will affect only this display. If the data is plotted, the plotted data will not have an offset.

3.2 Horizontal Controls

There are five controls that affect the horizontal display. Four of these five are associated with the
triggering. Each control is adjusted by clicking on either the up, or the down arrow.

The first control sets the time per division. This will be displayed in anything from nanoseconds to
seconds.

The second control sets which channel (Y1 or Y2) is the trigger source.

The third control sets whether the sweep triggers on a rising (POS) or falling (NEG) edge.

The fourth control sets the triggering level.

The final control sets the triggering mode - Normal, Auto, or Single.

Note that at slow sampling rates the communications with the 'scope may fail, as indicated by a
"Comm Err" message in the message status box. This problem occurs because the Digital 'Scope
does not always respond to requests for data in a timely fashion when the sweep rate and sampling
rate is low.
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3.3 Single Trigger Mode

In the single trigger mode, the scope must be re-armed before it can trigger again.

This is accomplished by clicking on the Arm item under the control menu. If the 'scope is already
armed, clicking on this menu item will trigger the 'scope.

3.4 Saving and Recalling the State

The state of the hardware can be saved to a file by clicking on the File | Save Setup or File | Save
Setup As menu item. This command will save all the hardware state associated with both vertical
channels, the horizontal sweep, and the trigger.

The hardware state may be recalled by clicking on the File | Recall Setup menu item. This will restore
the hardware to a previously recalled state.

If you would like to recall the hardware state to the same setup used for saving a plot, simply click on
the Recall Setup item, and select the plot file, rather than a setup file. The hardware state will be reset
to the conditions saved with that plot file. The plot will not be displayed.

4 Aquisition

4.1 Aquisition Modes

When HScope for the 90's is first launched, it will start into a loop of aquiring data from the hardware,
and immediately displaying it on the computer screen. However, several other modes are available for
handling the data as it is aquired. These modes are enabled through the Aquire Submenu.
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Either channel can aquire data in an average mode, or by holding the minimum or maximum data
values obtained from the 'scope.

4.2 Averaging

In the averaging mode, the average of up to 100 sets of data can be averaged to form a single trace.
This is useful for removing noise from a trace. The number of traces averaged is set by clicking on the
Set Avg menu item under the Aquire sub-menu. This will bring up the Avg Count Dialog:

 

The number of samples to average is selected, from 2 to 100. Pressing the OK button will close the
Dialog.

At this time, click on either the Ch 1 Average, or the Ch 2 Average menu item, to beginning averaging
the samples from the 'scope. Initiating averaging on either channel will start the averaging process
over. If both channels are averaging, the averaging process on the first channel will start over as the
channel averaging is initiated on the second of the two channels to be toggled on.

A message of the form "Avg: 3" will be displayed on the averaging status panel, keeping track of the
number of samples already averaged. When the count reaches the limit specified in the Avg Count
Dialog, the averaging is complete, and the trace or traces being averaged will no longer be updated. If
either trace is not being averaged, it will continue to update.

Averaging can be restarted by clicking on the Restart Collection menu item. Note that this will also
restart the minimum or maximum hold functions for the two channels.
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Averaging can be toggled off by again clicking on the Ch1 or Ch 2 Average menu items.

Note that clicking on the Average menu items will uncheck the Min or Max hold items, if either of these
are checked. The average collection, minimum hold, and maximum hold are all mutually exclusive
modes. Similarly, clicking on Min or Max hold will disable the averaging on that channel.

4.3 Min and Max Hold

Minimum or Maximum hold of the data aquired on a channel can be selected by clicking on the Ch 1 or
Ch 2 Max or Min Hold menu items. These menu items will have a check next the them if enabled.

The minimum or maximum hold functions will continue to operate until disabled, or until the Restart
Collection menu item is clicked. Clicking on the Restart Collection menu item will restart all averaging,
maximum hold, and minimum hold operations.

The average, maximum hold, and minimum hold functions are mutually exclusive - only one can be
enabled per channel. Enabling any one of the three will disable the other two.

5 Status Panel

5.1 Status

At the bottom of the HScope application window lie six status displays, as shown below.
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The first four displays show cursor data, if a cursor pair is enabled. If the vertical (time) cursors are
enabled, as shown above, these four display the time position of the first and second cursor, the
elapsed time between the two cursors, and the frequency corresponding to a single cycle between the
two cursors. If a horizontal cursor pair is enabled, the first three will display the voltage position of the
lower and upper cursors, while the third display will show the voltage difference between the two
cursors. The fourth display will be blank.

The fifth display will be blank unless averaging has been enabled for one or both channels. As shown
above, this display will then show the number of traces that have been averaged.

The final display shows the 'scope status. The following messages might be displayed here:

Transferring: This indicates that the 'scope is in the process of sending data to the computer.

Sampling: This indicates that the 'scope is aquiring data. This message is displayed only with
sweep speeds of 100 ms/div and slower, and is a reflection of the 'scope's response to
a request for data at these slow sweep speeds.

No Data: Sometimes the 'scope will be set up with both channels disabled. Under this condition
the 'scope will not be sending any data after going through an acquision cycle. When
this happens the appliction will display this message in the status area.

Wait: This is somewhat similar to the "Sampling" message above, but is not due to a
response from the 'scope. At sweep speeds below 100 ms/div, if the 'scope is in the
process of acquiring data, or waiting for a trigger, it appears to not respond to the
request for data until it has triggered and all the data has been gathered.

In the equivalent time sampling mode (200 us/div and less) the 'scope has to acquire
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512 cycles of the waveform to complete a single trace. If the waveform being
examined has a low duty cycle, this may take a long time. This program will request
data and wait - and wait - and wait.

Unfortunately the software has no way of knowing whether the 'scope is dead or alive
at this point. So the software assumes the 'scope is alive, and gathering data, or
waiting for a trigger. This assumption is indicated by displaying a "**Wait**" message
in the status area. If this condition lasts longer than you would expect, make sure the
'scope is triggering (are you in normal mode and not triggering?). This condition can
be aborted by changing any of the settings on the 'scope, which might prove useful if
somehow the 'scope has responded, but the software has missed the response. If the
'scope state and input signals have not changed, it would be reasonable to assume
that the software will immediately enter again into this "wait" state.

My experience with setting the 'scope up under conditions where a considerable time
is required to acquire the 512 samples, using hyperterminal to query ths 'scope,
seems to indicate that the 'scope can take much longer than expected to acquire
these 512 samples.

Triggered: Immediately after transfering data, this message may appear to affirm that the 'scope
was triggered when this data was acquired.

No Trigger: Immediately after transfering data, this message may appear to indicate that the
'scope was not triggered when this data was acquired. For this to occur the 'scope
must be in the auto trigger mode. If the 'scope is in the equivalent time mode (200
us/dive and less), the resulting waveform is most likely meaningless.

6 Using Cursors

6.1 Vertical (Time) Cursors

The new and improved version of HScope has the ability to display vertical cursors on the virtual 'scope
face. The vertical cursors are turned on by selecting the Cursors | Time menu item.
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In the above display, the vertical cursors have been enabled and set to measure the time difference
between two consecutive cycles of the square wave. The four status panels below the virtual 'scope
face show the position of the two cursors, as well as the difference in time between the two cursors,
and the corresponding frequency for a single cycle between the two cursors.

The cursors are moved by bringing the mouse cursor close to either cursor line, clicking the mouse
and dragging the cursor to the desired position.

The Cursors submenu items will toggle the cursors on and off. When a particular cursor has been
enabled, a check mark will appear next to the menu item. Clicking on this item again will disable the
cursors, and turn off the check mark.

Only one cursor pair can be selected at a time. If one of the horizontal cursors is enabled, the vertical
cursors will become disabled.

Note that the Cursors menu will reflect the cursors presently enabled on the highlighted Plot Window,
and will affect the cursors on the highlighted Plot Window, which may or may not be the Active Plot
Window.

6.2 Horizontal (Voltage) Cursors

The Cursors menu item will also allow the user to enable horizontal cursors to measure the voltage
levels for either channel 1 or channel 2 on the virtual display.
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Here the channel 2 horizontal cursors have been enabled to measure the minimum, maximum, and
peak to peak voltages of the square wave.

Again, the cursors are moved by bringing the mouse cursor close to either cursor line, clicking the
mouse and dragging the cursor to the desired position.

The Horizontal Cursors can be disabled by again clicking on the same Horizontal Cursor menu item. If
another cursor pair is enabled, this pair will become disabled.

Note that the Cursors menu will reflect the cursors presently enabled on the highlighted Plot Window,
and will affect the cursors on the highlighted Plot Window, which may or may not be the Active Plot
Window.

7 Colors Menu

7.1 Setting Plot Colors

The Colors menu item allows the user to specify the color for a number of items on the virtual scope
display.
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The ten menu items allow the user to select the color for the two traces, the six possible cursors, as
well as the background and grid colors. These color selections will be carried over to the data plots.

Note that the Trace Colors can be changed only on the active plot. This is because the color change
takes affect when the latest data set is plotted - which only occurs on the Active Window.

8 Plotting Data

8.1 Plotting Data

By clicking on the Plot | Channel 1 or Plot | Channel 2 menu items, a plot of the Channel 1 or Channel
2 data can be obtained.
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This is similar to the virtual 'scope display, except that the axes are now labeled with units. Another
difference is that the vertical axis extends upward and downward by an additional division, using more
of the A / D converter range. Note that the signal frequency has been changed for this plot to allow
room for the 11 time labels on the lower axis. This was required because the window's size has been
drastically limited here to allow the screen capture to fit easily within this document.

The Plot Window will contain only one trace. The two traces can be plotted in two different Plot
Windows.

The Plot can be copied to the clipboad by clicking on the Edit | Copy menu item.

8.2 Printing a Plot

Once a trace has been plotted using the plot command, it can be printed. On the Plot Window, click on
the File | Print menu item. This will bring up the Print Dialog. Clicking OK on the Print Dialog will send
the plot to the printer. The print command is very rudimentary. The print out can be made smaller or
larger by making the Plot Window smaller or larger.

Selecting the File | Resize menu item will re-size the plot so it will better fit a letter size landscape sheet
of paper.
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9 Menu Summaries

9.1 Main Window Menu Overview

There are nine main items on the menu bar. These nine main menu choices are:

File Used to print, save and recall traces and setup conditions, and exit.

Edit Used to save a plot onto the clipboard

Plot Used to plot either trace with defined axes.

Aquire Used to set up averaging, or minimum or maximum hold.

Control Used to send commands to the scope.

Cursors Used to enable and disable cursors for measuring time and voltages.

Colors Used to select the colors for various element on the display and plots.

Window Used to Tile or Cascade multiple windows, or select a windows.

Help Used to display this help file, or the Help About dialog.

9.2 File Menu

The file menu is used for saving and recalling plots and setup states, as well as creating a new Trace
Window, and exiting the program. Most items on this menu refer to the currently selected (highlighted)
Trace Window, or create a new, selected Trace Window.

New Create a new Trace Window. This window will become the Active Trace Window

Recall Plot Recall Waveform from file

Save Plot Save Waveform to file using present name

Save Plot As... Save Waveform to file with a new name
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Recall Setup Recall Setup State from file

Save Setup Save Setup State using present name

Save Setup As... Save Setup Stat to file with a new name

Print Print Image of Trace Window

Print Setup... Open Printer Setup Dialog

Exit Exit Application

9.3 Edit Menu

The Edit menu contains a single item. This item refers to the currently selected Trace Window.

Copy Copy bitmap image of the Trace Window to the Clipboard

9.4 Plot Menu

The Plot Menu contains two items. The are both used to plot trace data from the currently selected
Trace Window. Chose the correct item to plot the desired trace.

Channel 1 Plot Channel 1 Data

Channel 2 Plot Channel 2 Data

9.5 Aquire Menu

The Aquire menu is used to control the aquisition of data in the Active Trace Window. This is not
necessarily the currently selected Trace Wndow.

The first six menu choices can be toggled. If they are on, a check mark will appear to the left of the
menu item. For example, clicking on the first item, will place a check mark next to the Ch 1 Average
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menu item, and will turn on averaging of channel 1. Clicking it again will turn it back off.

The first three items are mutually exclusive. That is, checking any one will un-check the other two.
Thus any of the three items can be toggled on or off, but turning on any of the three will automatically
turn off the other two. The same is true of the next three menu items, which control the aquisition of
channel 2.

The following menu items are included:

Ch 1 Average Average multiple data from Channel 1

Ch 1 Max Hold Hold Maximum values from multiple data from Channel 1

Ch 2 Min Hold Hold Minimum values from multiple data from Channel 1

Ch 2 Average Average multiple data from Channel 2

Ch 2 Max Hold Hold Maximum values from multiple data from Channel 2

Ch 2 Min Hold Hold Minimum values from multiple data from Channel 2

Set Avg Set Number of samples to average

Restart Collection Restart collection for averaging, or min or max hold

A single counter is used for averaging both channels. Thus, any time either channel is set to averaging,
averaging is reset for the other channel as well, if it is averaging. Averaging will continue until the
number of samples specified using the Set Avg menu item have been taken. At that time, the averaged
display will no longer be updated.

Clicking on the Restart Collection menu item will restart all the collections, either averaging, or the min
or max hold functions.

9.6 Control Menu

The Control menu is used to send control codes to the Digital Memory Oscilloscope. The following
items are included in the Control menu:

Zero Performs a DC zero of the vertical channels

Arm Arms the 'scope for single trace, or trigger, if the 'scope is already armed.

Scope This is a toggle control. Clicking on Scope will toggle a check mark to the left of the menu
item. If Scope is checked, the DMS will send data to an external oscilloscope for display. If
it is not checked, the external 'scope is disabled. Leaving this item unchecked should
speed up the computer display.

Reset Clicking on this menu item will perform a power up reset of the hardware.
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9.7 Cursors Menu

The Cursors Menu allows the user to enable or disable the vertical and horizontal cursors, allowing the
user to measure time and voltages on the display. These menu items are toggles, displaying a check
mark when the cursor is enabled.

Only one cursor pair can be displayed at a time. If another cursor pair is enabled, any other cursor that
was enabled will become disabled.

The Cursor Menu will track whatever plot window the user has selected, reflecting any cursor pair that
may be presently enabled in that window. Cursor selections will be applied to the currently selected
window.

9.8 Colors Menu

The Colors Menu allows the user to select the colors of ten different items in the plot windows. Some
of these color selections will also apply to any plots created using the Plot menu item. Selecting an
item in this menu will bring up a standard color dialog:
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In this dialog, the user has pressed the "Define Custom Colors >>" button, bringing up the custom color
selection area at the right side of the dialog. In this case, the color selected appears to be black.

Selections made from the Colors menu will be applied to the currently highlighted, or selected window,
not the Active window. The Trace colors can be changed only on the Active window. This is because
the trace colors are updated as new data is plotted. Since new data is plotted only in the Active
window, you can change their colors only in the Active window.

9.9 Window Menu

The Window Menu allows the user to select either Tiled, or Cascaded Trace Windows, and to select a
window to bring forward as the highlighted window.

Tile Tile Trace Windows

Cascade Cascade Trace Windows

If the windows are Tiled, or Cascaded, they will grow and shrink as the main window is resized.
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9.10 Help Menu

The Help Menu contains two items:

Contents Brings up this help file

About... Brings up the Help About dialog for this application

9.11 Plot Window Menu Overview

The Plot Windows have two main items on the menu bar:

File Used to print the plotted data.

Edit Used to save the plotted data onto the clipboard

9.12 File Menu

The File Menu in the Plot Window allows the user to print the data plotted in the window.

Print Print Image of Trace Window

Print Setup... Open Printer Setup Dialog

Resize Resize the window to fit a letter sized landscape sheet of paper.

The printed image will be a higher resolution version of the plot displayed in the window.

9.13 Edit Menu

The Edit menu contains a single item.

Copy Copy a bitmap image of the plotted data to the Clipboard
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